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P300   
IntelliMix  Audio Conferencing Processor

Overview
General Description
The P300 IntelliMix Audio Conferencing Processor offers IntelliMix DSP algorithms optimized for audio/video conferencing ap­
plications, featuring 8 channels of acoustic echo cancellation, noise reduction and automatic gain control to ensure a high­qual­
ity audio experience.

The P300 provides Dante (10 in/8 out), analog (2 block in/2 block out), USB (1 in/out) and mobile (3.5 mm) connectivity options 
that makes connecting to room systems and collaborating with laptops and mobile devices easier than ever.

Features
Connects 10 Dante  audio inputs, 2 analog inputs, USB, and a mobile device to an A/V conferencing system or a PC-
based videoconferencing application
Includes IntelliMix DSP algorithms to enhance audio quality in A/V conferences: 8 channels of AEC (acoustic echo cancel­
lation), noise reduction, and automatic gain control, combined with automatic mixing, matrix mixing, delay, compressor 
and parametric equalization
Flexible signal routing and connectivity: analog audio (2 block in/2 block out) to connect to room A/V conferencing system; 
USB (1 in/out) to connect to laptop or room PC; one 3.5 mm TRRS jack to connect to a mobile device to enable an addi­
tional participant to join
Power over Ethernet Plus (PoE+) eliminates the need for an outboard power supply
Compact form factor is easy to mount without equipment rack

Getting Started
Videoconferencing Room Equipment
Your P300 is one part of a complete room system for videoconferencing. It's helpful to think about all the parts of your room 
system as you get started setting up the P300.

®

™
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Large room equipment example

A standard room includes some or all of this equipment:

Microphone(s)
DSP or other processor
Loudspeakers (networked or analog)
Computer with videoconferencing software
Network switch
Camera
Other accessories such as table mute buttons, tablets to control meetings, and other peripherals

The Microflex
®
 Ecosystem offers a complete portfolio of networked audio solutions that can be precisely tailored to your needs.

P300 Designer Setup Example
This example uses Shure Designer 6.0 software to set up a P300, 2 MXA901 microphones, and 4 MXN5-C loudspeakers. You 
might use Designer if:

You're managing many Shure devices in different spaces
You're routing audio between many Shure devices

You can use other combinations of devices with the P300, but the setup process in Designer is similar.

After completing this basic setup process, you should be able to:

Control the P300 in Designer
Route audio and adjust DSP settings
Understand the basic workflow for working with devices in Designer

This example uses:

Cat5e (or better) Ethernet cable

https://www.shure.com/en-US/conferencing-meetings/solutions/microflex-ecosystem
https://www.shure.com/en-US/conferencing-meetings/solutions/microflex-ecosystem
https://www.shure.com/en-US/conferencing-meetings/solutions/microflex-ecosystem
https://www.shure.com/en-US/conferencing-meetings/solutions/microflex-ecosystem
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Network switch that provides Power over Ethernet Plus (PoE+)
Computer with Designer 6.0 or newer (download at shure.com/designer)
Computer with videoconferencing software
2 MXA901 microphones
4 MXN5-C loudspeakers

Step 1: Install and Connect
Install the P300 and other devices. Connect the P300 and MXN5-C loudspeakers PoE+ ports on the network switch. 
The MXA901s only require PoE.
Connect the computer with videoconferencing software (such as Zoom or Microsoft Teams) to the P300's USB port.

Connect the computer running Designer to the same network.
Open Designer. Check that you’re connected to the correct network in File > Designer preferences.
Open a new design and drag the devices into the design.

Step 2: Route Audio and Apply DSP
The easiest way to route audio and apply DSP is with Designer's auto route feature. This feature routes audio signals, applies 
DSP settings, turns on mute synchronization, and enables LED control for connected devices.

Select Auto route. Designer makes the following audio routes:
MXA901s to P300 inputs
P300 output to MXA901 AEC reference inputs
P300 output to MXN5-C inputs

http://www.shure.com/designer
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The P300's matrix mixer creates these routes:

Check the audio routes, matrix mixer routes, and other settings to make sure they fit your needs. You might need to:
Delete unnecessary routes.
Verify that AEC reference signals are correctly routed.
Fine-tune DSP blocks as needed.
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Select Deploy and connect to send the settings to the installed devices. Designer walks you through associating the de­
sign devices with the online devices.

Step 3: Listen and Adjust
Open the videoconferencing software on the computer connected to the P300. In the settings, choose the P300 as the 
speaker and microphone.
Place a test call with the whole system. Have the far-end caller tell you how the microphone signals sound and make 
adjustments as needed:

P300: [Your room] > P300. The schematic tab shows all DSP blocks, and the inputs and outputs tabs have chan­
nel gain faders.
Microphone coverage: [Your room] > Coverage
MXA901s: [Your room] > MXA901-R
MXN5-Cs: [Your room] > MXN5-C

This combination of devices uses the MXA901s for AEC. The P300 output signal that feeds the 4 loudspeakers is the 
AEC reference source.

For other setups, you should check that the AEC reference source is correct. Use the channel that carries audio to 
loudspeakers as the AEC reference.

P300 Parts

Rear panel

Front panel
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① Mobile Input
TRRS mobile input connects to a mobile device. Supports bidirectional audio with a TRRS cable, or sends audio into the 
P300 with a TRS cable.

Note: See the cable requirements for additional information.

Pin Assignments

Tip Audio Input (Left)

Ring 1 Audio Input (Right )

Ring 2 Ground

Sleeve Audio Output (To Phone)

Note: Left and Right audio signals are summed to a mono signal.

② Audio Inputs (Block Connector)
Balanced audio input connects to an analog audio device. Set the analog input level to match the output level of the analog 
device.

Input sensitivity:

Line (+4 dBu)

Aux (−10 dBV)

Block Pin Assignments:

Plus sign: Audio +
Minus sign: Audio −
Ground symbol: Audio ground

③ Chassis Ground Screw
Provides an optional connection for microphone shield wire to chassis ground.

④ Audio Outputs (Block Connector)
Balanced audio output connects to an analog device. Set the output level to match the input sensitivity of the analog device 
(Line, Aux, or Mic level).

Plus sign: Audio +
Minus sign: Audio −
Ground symbol: Audio ground

⑤ USB Port
Connects to a computer to send and receive audio signals. Use the matrix mixer to sum any combination of signals from 
the P300 into a single mono channel and send through the USB output.

⑥ Dante Network Port
Connects to a network switch to connect Dante audio, Power over Ethernet (PoE), and data from the control software.

⑦ Reset Button
Resets the device settings back to the factory default.



Shure Incorporated

10/49

⑧ LED Indicators

Power: Power over Ethernet Plus (PoE+) present

Network: Ethernet connection active

Network Audio: Dante audio present on the network

Network Audio LED Behavior

LED Status Activity

Off No active signal

Green Device is operating successfully

Red
Error has occurred. See event log in device web application 
for details.

Encryption LED Behavior

LED Status Activity

Off Audio not encrypted

Green Encryption enabled

Red

Encryption error. Possible causes:

Encryption is enabled on one device and not on another
Passphrase mismatch

USB LED Behavior

LED State Status

Off No USB device connected

Green USB device operating successfully

Red (flashing) Problem detected with connected USB audio device
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Note: Error details are available in the event log in the device web application.

⑨ Level Indicators (Signal/Clip)

Tri-color LEDs indicate the audio signal level for the analog channels. Adjust output levels to avoid clipping.

Analog Input/Output

LED State Audio Signal Level

Off less than −60 dBFS

Green −59 dBFS to −24 dBFS

Yellow −23 dBFS to −1 dBFS

Red 0 dBFS or more

Note: The input and output LEDs stay off when metering is set to Post-gain and the channel is muted.

Power Over Ethernet Plus (PoE+)
This device requires PoE Plus (PoE+) to operate. It is compatible with Class 4 PoE+ sources.

PoE+ is delivered in one of the following ways:

A network switch that provides PoE+
A PoE+ injector device (must be a gigabit device)

Cable Requirements
Always use Cat5E cable or higher.

Control Devices with Shure Designer Software
To control this device's settings, use Shure Designer software. Designer enables integrators and system planners to design au­
dio coverage for installations using MXA microphones and other Shure networked devices.

To access your device in Designer:

Download and install Designer on a computer connected to the same network as your device.
Open Designer, and check that you’re connected to the correct network in File > Designer preferences.
Click Online devices. A list of online devices appears.
To identify devices, select a device and click ID in the Properties menu. Double-click the device to open the settings.

From here, you can add devices to designs or online rooms and route audio to other Shure devices. Learn more at shure.com/
designer.

You can also access device settings using Shure Web Device Discovery.

What's in the Box
KIT, HARDWARE, P300-IMX 90D33522

BRACKET, HALF RACK UNIT 53A27741

USB cable 95A39698

http://www.shure.com/designer
http://www.shure.com/designer
https://www.shure.com/en-US/products/software/shure_web_device_discovery_application
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Reset
The reset button is located inside a small hole in the rear panel. Use a paperclip or other small tool to press the button.

There are 2 hardware reset functions:

Network reset (press button for 4-8 seconds)
Resets all Shure control and audio network IP settings to factory defaults.

Full factory reset (press button for longer than 8 seconds)
Resets all network and Designer settings to the factory defaults.

Software Reset Options
Reboot Device (Settings > Factory Reset): Power-cycles the device as if it were unplugged from the network. All settings 
are retained when the device is rebooted.

Restore Factory Defaults (Settings > Factory Reset): Restores all network and Designer settings to the factory defaults. 
This is the same as performing a full factory reset using the reset button on the device.

Default Settings (Presets > Restore default settings): Resets audio settings back to the factory configuration (exclud­
ing device name, IP settings, and passwords).

Use Designer's Auto Route
Designer's auto route speeds up the process of connecting systems with 1 audio processor and at least 1 microphone. Auto 
route also creates mute control routes in rooms with MXA network mute buttons. When you select Auto route, you can direct 
Designer to:

Create audio routes and mute control routes
Adjust audio settings
Turn on mute synchronization
Enable LED logic control for applicable devices

The settings are optimized for your particular combination of devices. You can adjust settings further, but auto route gives you a 
good starting point. Auto route works with any device in Designer.

To use auto route:

Place all relevant devices in a design.
Select Auto route. Designer optimizes microphone and DSP settings for your equipment combination.

If you remove or add devices, select Auto route again.

Note: The auto route process clears any manual routes you may have made in your design.

After auto routing a room, check and adjust settings to fit your needs. You may need to:

Delete unnecessary routes.
Check levels and adjust gain.
Check that AEC reference signals are correctly routed and received in a test call.
Fine-tune DSP blocks.
Adjust your processor's matrix mixer routes.
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If you want to auto route an online room, turn on online room editing in File > Designer preferences.

Note: Changes to an online room may cause audio to briefly drop out.

Refer to Designer's Troubleshooting section for help with routing.

DSP Settings
Acoustic Echo Cancellation
In audio conferencing, a far-end talker may hear their voice echo as a result of a near-end microphone capturing audio from 
loudspeakers. Acoustic echo cancellation (AEC) is a DSP algorithm which identifies the far-end signal and stops it from being 
captured by the microphone to deliver clear, uninterrupted speech. During a conference call, the AEC works constantly to opti­
mize processing while far-end audio is present.

When possible, optimize the acoustic environment using the following tips:

Reduce loudspeaker volume
Position loudspeakers farther from microphones
Avoid pointing loudspeakers directly at microphone coverage areas
If the microphone is providing AEC from the automix output, turn off AEC on the processor. Designer's auto route applies 
these settings automatically.

Select a Reference Signal for AEC
To apply AEC, provide a far end reference signal. For best results, use the signal that also feeds your local reinforcement sys­
tem.

P300: Go to Schematic and click any AEC block. Choose the reference source, and the reference source changes for all 
AEC blocks.
MXA710, MXA901, MXA910, MXA920: Route a far-end signal to the AEC Reference In channel.
IntelliMix Room: Go to Schematic and click an AEC block. Choose the reference source. Each block can use a different 
reference source, so set the reference for each AEC block. When stereo audio is on, you can set different left and right 
channel reference sources as needed.

Designer's auto route process automatically routes an AEC reference source. However, you should check that Designer choos­
es the reference source you want to use.

Note: Always send an AEC reference signal to microphones with AEC processing, even if you are using a separate DSP for AEC. Designer's auto route fea­
ture automatically creates these routes.

AEC Settings

Reference Meter
Use the reference meter to visually verify the reference signal is present. The reference sig­
nal should not be clipping.

ERLE
Echo return loss enhancement (ERLE) displays the  dB level of signal reduction (the amount 
of echo being removed). If the reference source is connected properly, the ERLE meter ac­
tivity generally corresponds to the reference meter.

Reference Indicates which channel is serving as the far end reference signal.

https://pubs.shure.com/guide/Designer/en-US#c_07601b9f-5da8-414d-a01b-9f5da8214d19
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Non-Linear Processing

The primary component of the acoustic echo canceller is an adaptive filter. Non­linear pro­
cessing supplements the adaptive filter to remove any residual echo caused by acoustic ir­
regularities or changes in the environment. Use the lowest possible setting that is effective in 
your room.
Low: Use in rooms with controlled acoustics and minimal echoes. This setting provides the 
most natural sound for full duplex.
Medium: Use in typical rooms as a starting point. If you hear echo artifacts, try using the 
high setting.
High: Use to provide the strongest echo reduction in rooms with bad acoustics, or in situa­
tions where the echo path frequently changes.

Automatic Gain Control (AGC)
Automatic gain control adjusts channel levels to ensure consistent volume for all talkers, in all scenarios. For quieter voices, it 
increases gain; for louder voices, it attenuates the signal.

Automatic gain control is post­fader, and adjusts the channel level after the input level has been adjusted. Enable it on chan­
nels where the distance between the talker and the microphone may vary, or in rooms where many different people will use the 
conferencing system.

Target Level (dBFS)

Represents the level that you want the gain to reach. This level is different from adjusting the input fader according to peak 
levels to avoid clipping. Suggested starting points:

P300: -32 dBFS
MXA910: -37 dBFS
IntelliMix Room: -32 dBFS

Maximum Boost ( dB)

Sets the maximum amount of gain that can be applied

Maximum Cut ( dB)

Sets the maximum attenuation that can be applied

Tip: Use the boost/cut meter to monitor the amount of gain added or subtracted from the signal. If this meter is always reach­
ing the maximum boost or cut level, adjust the input fader so the signal is closer to the target level.

Noise Reduction
Noise reduction significantly reduces the amount of background noise in your signal caused by projectors, HVAC systems, or 
other environmental sources. It is a dynamic processor, which calculates the noise floor in the room and removes noise 
throughout the entire spectrum with maximum transparency.

Settings
The noise reduction setting (low, medium, or high) represents the amount of reduction in dB. Use the lowest possible setting 
that effectively lowers noise in the room.

Compressor
Use the compressor to control the dynamic range of the selected signal.
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Threshold

When the audio signal exceeds the threshold value, the level is attenuated to prevent unwanted spikes in the output sig­
nal. The amount of attenuation is determined by the ratio value. Perform a soundcheck and set the threshold 3-6 dB above 
average talker levels, so the compressor only attenuates unexpected loud sounds.

Ratio

The ratio controls how much the signal is attenuated when it exceeds the threshold value. Higher ratios provide stronger 
attenuation. A lower ratio of 2:1 means that for every 2 dB the signal exceeds the threshold, the output signal will only ex­
ceed the threshold by 1 dB. A higher ratio of 10:1 means a loud sound that exceeds the threshold by 10 dB will only ex­
ceed the threshold by 1 dB, effectively reducing the signal by 9 dB.

Delay
Use the delay feature on the analog and USB outputs to synchronize audio and video. When a video system introduces laten­
cy (where you hear someone speak, and their mouth moves later), simply add delay to the analog outputs to align with the 
video. Delay can also be used in larger rooms to align the arrival time or phase between multiple speakers.

The delay is measured in milliseconds. If there is a significant difference between audio and video, start by using larger inter­
vals of delay time (500-1000 ms). When it is closer to full synchronization, use smaller intervals to fine-tune.

The USB output channel features delay to ensure the near-end camera and near-end audio are synchronized.

Schematic View
The schematic view in Designer provides an overview of the entire audio signal chain, with the ability to adjust settings and 
monitor signals. The schematic view in each device looks slightly different because each device has different inputs and out­
puts.

Example of the P300's schematic view
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Adjusting Settings
Right-click an input, output, or processing block to access the following options:

Channel Settings

Setting Function

Copy / paste

Copy and paste settings between items. For example, set 
the equalizer curve on the USB output, and then use the 
same setting for the analog output. Or, copy the gain and 
mute status from one input channel to several others.

Mute / unmute Mutes or activates the channel

Enable / disable
Turns processing on or off (does not apply to matrix mixer or 
automixer)

Edit
Opens the dialog to adjust parameters. You can also double-
click a block to edit it.

Right-click in a blank area to access global settings:

Mute/unmute all input channels
Mute/unmute all output channels
Close all open dialogs

Customizing the Workspace
Create a custom environment to monitor and control a set of inputs, outputs, and processing blocks from a single screen. 
There are 2 ways to break out dialogs:

Right-click  >  Edit
Double-click the input, output, or processing block.

Open as many dialogs as you need to keep important controls available.

Metering and DSP Blocks
A meter appears underneath each input and output to indicate signal levels (dBFS).

DSP blocks have a color when they are turned on. When off, they are gray. Use these tools to troubleshoot audio signals and 
verify connections and levels.

Matrix Mixer
The matrix mixer routes audio signals between inputs and outputs for simple and flexible routing:

Send a single input channel to multiple outputs
Send multiple input channels to a single output

Crosspoint Gain
Crosspoint gain adjusts the gain between a specific input and output, to create separate submixes without changing input or 
output fader settings. Select the dB value at any crosspoint to open the gain adjustment panel.



Shure Incorporated

17/49

Gain staging: Input fader > crosspoint gain > output fader

Routing Channels
Connect inputs and outputs by selecting the box where they intersect.

P300 Default Settings
The default configuration enables calling to multiple far ends with near-end Shure microphones. Connections are established 
for operating hardware codecs, software codecs, and mobile phones simultaneously.

Input/Source Channel Output/ Destination Channels

Automix (summed Dante input channels)
Analog - To Codec (Analog output 1)
USB output
Mobile output

Analog - From Codec (Analog input 1)
Analog - To Speaker (Analog output 2)
USB output
Mobile output

USB input
Analog - To Codec (Analog output 1)
Analog - To Speaker (Analog output 2)
Mobile output

Mobile input
Analog - To Codec (analog output 1)
Analog - To Speaker (analog output 2)
USB output

Example Scenario: Connecting a Three-Way Call
Near-end audio from Dante microphones (Shure MXA 310) and the mobile phone are both routed to the video codec and sent 
to the far end. The mobile phone is simply carrying the audio from the remote caller -- its built-in microphone and speaker are 
disabled.
Far-end audio from the video codec is routed to a powered loudspeaker or amplifier (analog or Dante­enabled). It is also rout­
ed to the mobile phone (connected to the P300) to relay the signal to the remote caller.
The remote caller (far end) receives audio from both the near-end and far-end locations. The P300 connects all locations by 
routing both near and far-end audio sources through the mobile output. The audio from the remote caller is routed to the mobile 
input, and then sent to the loudspeakers in the near-end room and through the video codec to the far-end room.
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Input / Source Channel Output / Destination Channel

Automix (four summed Dante input channels from 
MXA310)

Analog - To Codec (analog output 1)

Mobile output

Analog - From Codec (analog input 1)
Analog - To Speaker (analog output 2)

Mobile output

Mobile input
Analog - To Codec (analog output 1)

Analog - To Speaker (analog output 2)

Installation and Rack Mounting
Two mounting solutions are available for installing the P300:

CRT1 19" Rack Tray (optional accessory): Supports up to 2 devices (two P300s or one P300 and one ANI4IN, ANI4OUT, 
ANI22, or ANIUSB); mountable in a rack or under a table

Single-unit Mounting Tray (included accessory): Supports a single device for mounting under a table
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Securing the Devices
Use the included screws from the mounting hardware kit to secure each P300 or Audio Network Interface (ANI). Devices can 
be mounted to face either direction. Insert the screws from the bottom in the appropriate holes, according to the following dia­
grams:

Align the holes as shown for securing a single device in the single-unit mounting tray
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Align the holes as shown for securing up to two devices in the 19" rack tray.

Rack Ear Configuration (CRT1)
The adjustable rack ears support mounting in a standard equipment rack or underneath a table.

Standard 19" Rack Mount
Align the ears with the mounting holes pointed forward.
Install the two screws that hold the ear to the tray as shown.

Under-table Mounting
Align the ears with the mounting holes pointed upward.
Install the two screws that hold the ear to the tray as shown.
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Installing Underneath a Table
Hold the tray in the desired location under a table
Use a pencil to mark the location of the mounting holes on the table.
Drill 4 holes for the screws. The diameter of the holes in the tray are 7.1 mm.
Install the components into the tray
Install with 4 screws to secure the tray underneath the table

Mute Sync
It’s important to be able to see if a room is muted or unmuted during a call. You want devices to show the same mute status as 
the videoconferencing software. Shure devices use logic and mute sync to make this happen.

Logic: Aligns mute status across Shure devices in the room. The processor (such as a P300, IntelliMix Room software, or 
an ANIUSB-MATRIX) is the controller.
Mute sync: Aligns mute between the processor and the videoconferencing software, which is on a computer connected to 
the processor by USB. The processor’s automix output is muted or unmuted to change the mute status of the system.

When mute sync is working correctly, you can mute a device (mute button or microphone mute button) or the videoconferenc­
ing software to mute the room.

To use mute sync:

In Designer, create audio and mute control routes between devices in the room.
Connect a computer with videoconferencing software to the processor's USB port.
Turn on mute sync and logic:

Processors: [Your device] > Settings > Mute control
Microphones without physical mute button: Logic is always on
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MXA310 and MXA mute button: Settings > Logic control > Mute control function > Logic out

Designer's auto route process configures all necessary mute sync and logic settings for you.

Compatible Shure Logic Devices
P300 (Also mutes supported soft codecs connected by USB)
ANIUSB-MATRIX (Also mutes supported soft codecs connected by USB)
IntelliMix Room software (Also mutes supported soft codecs connected by USB)
MXA901
MXA902
MXA910
MXA920
MXA710
MXA310
Network Mute Button
ANI22-BLOCK
ANI4IN-BLOCK
Logic-enabled MX microphones connected to ANI22-BLOCK or ANI4IN-BLOCK

MX392
MX395-LED
MX396
MX405/410/415

For help with specific mute sync implementations, see our FAQs.

Use Call Status
Designer's call status feature uses microphone LEDs to show if you're in a videoconferencing call or not. This is a room-level 
feature, so it applies to all microphones in the same Designer room.

To use call status:

Put all microphones and processors (ANIUSB-MATRIX, IntelliMix Room, or P300) in the same Designer room.
Select Auto route to create audio and mute control routes. You can also route audio manually.
Go to [Your room] > Settings > Call status to turn on call status.

When call status is on:

Microphone LEDs off = Not in a call
Microphone LEDs on = In a call

Call status is compatible with the following codecs:

Microsoft Teams
Microsoft Teams Rooms
Zoom Client for Meetings
Zoom Rooms

Note: If your codec is running on a computer with a Chrome operating system, call status will not work.

https://www.shure.com/en-US/products/mixers/p300
https://www.shure.com/en-US/products/mixers/aniusb-matrix
https://www.shure.com/en-US/products/software/intellimix_room
https://www.shure.com/americas/support/find-an-answer
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Adjusting Input levels
The Inputs tab controls a channel's gain before it reaches the matrix mixer. However, you should also adjust the source's gain 
before it reaches the P300.

To monitor a source's input level before it reaches the P300: Set metering to Pre-gain in the Settings menu.

To adjust channel gain in the P300's Inputs tab: Set metering to Post-gain in the Settings menu.

Digital Sources (Dante and USB)
Check the source level before it reaches the P300:

Verify that the networked microphones or other Dante sources are operating at nominal output levels.
Set USB volume on the computer to the maximum setting if the volume control is accessible.
Adjust levels for MicroflexAdvance  and Microflex Wireless microphones in their web applications.

Adjust the P300's input gain in Designer:
Use the faders or manually enter a gain value. This gain stage adjusts the level of the signal before it reaches the 
matrix mixer.
Mix the levels as high as possible without the loudest channel reaching the peak level (0 dB) on the meter.

Note: The Matrix mixer tab lets you adjust crosspoint gain, which controls the levels for the separate submixes being sent to the different outputs.

Analog Sources
Check the source level before it reaches the P300, and set any analog device with adjustable output levels to a nominal 
level.
In Designer, choose Line (+4dBu) or Aux (-10dBV) to match the incoming signal level for each analog input channel.
Use each channel's fader to adjust the gain before it goes to the matrix mixer.

Mobile Devices
The mobile device input gain is optimized for most devices when the fader is set at 0 dB. It provides adequate volume with suf­
ficient headroom. As a general target, the audio signal received by the P300 from the phone should reach an average level of 
approximately -24 dBFS.

Set the phone to approximately 50% volume.
Set the input gain to 0 dB.
Make a test call to verify the following:

Can you clearly hear the far-end talker?
Can the far-end talker clearly hear audio from the near end?

If the signal being sent to the far end is too quiet, check and adjust the gain levels for the near­end microphones and the au­
tomixer.

Parametric Equalizer (PEQ)
Maximize audio quality by adjusting the frequency response with the parametric equalizer (PEQ). Use the input equalizers to 
make adjustments to specific channels, while using the output equalizers to adjust frequency response of all signals that are 
summed through a given output.

Common equalizer applications:

Improve speech intelligibility
Reduce noise from HVAC systems or video projectors
Reduce room irregularities
Adjust frequency response for reinforcement systems

™
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Note: If you're connecting a microphone that has a built-in equalizer (such as an MXA310), disable any EQ on the mic and use the P300's EQ instead.

2-Band Equalizers
Adjust filter settings by manipulating the icons in the frequency response graph, or by entering numeric values. Disable a filter 
using the check-box next to the filter.

Filter Type
Each band has a selectable filter:

Low Cut: Rolls off the audio signal below the selected frequency

Low Shelf: Attenuates or boosts the audio signal below the selected frequency

High Cut: Rolls off the audio signal above the selected frequency

High Shelf: Attenuates or boosts the audio signal above the selected frequency

Frequency
Select the center frequency of the filter to cut/boost

Gain
Adjusts the level for a specific filter (+/- 30 dB)

4-Band Equalizers
Adjust filter settings by manipulating the icons in the frequency response graph or by entering numeric values.
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Filter Type

Parametric: Attenuates or boosts the signal within a customizable frequency range

Low Cut: Rolls off the audio signal below the selected frequency

Low Shelf: Attenuates or boosts the audio signal below the selected frequency

High Cut: Rolls off the audio signal above the selected frequency

High Shelf: Attenuates or boosts the audio signal above the selected frequency

Frequency
Select the center frequency of the filter to cut/boost.

Gain
Adjusts the level for a specific filter (+/− 30 dB).

Q
Adjusts the range of frequencies affected by the filter. As this value increases, the bandwidth becomes thinner.
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Width
Adjusts the range of frequencies affected by the filter. The value is represented in octaves.

Note: The Q and width parameters affect the equalization curve in the same way. The only difference is the way the values are represented.

Equalizer Applications
Conferencing room acoustics vary based on room size, shape, and construction materials. Use the guidelines in following ta­
ble.

EQ Applications

EQ Application Suggested Settings

Treble boost for improved speech intelligibility
Add a high shelf filter to boost frequencies greater than 1 
kHz by 3 to 6 dB.

HVAC noise reduction Add a low cut filter to attenuate frequencies below 200 Hz.

Reduce flutter echoes and sibilance

Identify the specific frequency range that "excites" the room:

Set a narrow Q value.
Increase the gain to between +10 and +15 dB, and 
then experiment with frequencies between 1 kHz and 
6 kHz to pinpoint the range of flutter echoes or sibi­
lance.
Reduce the gain at the identified frequency (start be­
tween −3 and −6 dB) to minimize the unwanted room 
sound.

Reduce hollow, resonant room sound

Identify the specific frequency range that "excites" the room:

Set a narrow Q value.
Increase the gain to between +10 and +15 dB, and 
then experiment with frequencies between 300 Hz 
and 900 Hz to pinpoint the resonant frequency.
Reduce the gain at the identified frequency (start be­
tween −3 and −6 dB) to minimize the unwanted room 
sound.

Adjusting Output Levels
Tip: Set the output metering in the settings menu to ensure accurate metering.

Adjust faders in the Outputs section as high as necessary, but make sure to avoid clipping (when the signal reaches 0 dBFS). 
Always adjust the input gain and crosspoint gain in the matrix mixer before the output gain.

Analog output level:Select Line, Aux, or Mic level output signal to match the sensitivity of the receiving device.
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Pre- and Post-Gain Metering
The 2 metering modes allow you to monitor signal levels before and after the gain stages.

Input Metering
Pre-gain: Displays the pre-fader signal level. If signals are too low or clipping, adjust them at the source.
Post-gain: Displays the post-fader signal level, so the meters reflect gain adjustments on input faders. This meter does 
not include automatic gain control or any other processing.

Output Metering
Pre-gain: Displays signal levels after input gain has been applied, but before the output faders. This meter includes input 
faders, digital signal processing blocks, automixing, and crosspoint gain.
Post-gain: Displays the post-fader signal level sent to each output. This meter includes gain adjustments made on the 
output faders.

Automix
Automix Channel
This channel automatically mixes the audio from all selected channels to a single output. To adjust the automix channel set­
tings, go to:

MXA710, MXA910, MXA920:[Your device] > IntelliMix > Properties
P300 and IntelliMix Room:[Your device] > Automixer > Properties

All IntelliMix DSP blocks can be applied to the automix channel.

To use the automix channel, do the following:

Check that Send to mix is automatically selected (blue) for all channels. To exclude channels from the automix channel 
and treat them as individual direct outputs, deselect Send to mix (gray).
Route the automix channel in Designer or Dante Controller.

Automix Settings
Use these settings to adjust the automixer. Designer adjusts these settings automatically if you use the auto route feature, but 
you can customize to fit your installation. To adjust, go to:

MXA710, MXA910, MXA920:[Your device] > IntelliMix > Properties
P300 and IntelliMix Room:[Your device] > Automixer > Properties

Note: Not all settings are available on all automixers.
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Automix Settings

Setting Function

Leave last mic on

Keeps the most recently used microphone channel active. 
The purpose of this feature is to keep natural room sound in 
the signal so that meeting participants on the far end know 
the audio signal has not been interrupted.

Gating sensitivity
Changes the threshold of the level at which the gate is 
opened

Off attenuation
Sets the level of signal reduction when a channel is not ac­
tive

Hold time
Sets the duration for which the channel remains open after 
the level drops below the gate threshold

Maximum open channels
Sets the maximum number of simultaneously active chan­
nels

Automix gain meter
When enabled, changes gain meters to display automix gat­
ing in real time. Channels that gate open will display more 
gain than channels that are closed (attenuated) in the mix.

Priority
When selected, this channel gate activates regardless of the 
number of maximum open channels.

Always on When selected, this channel will always be active.

Send to mix When selected, sends the channel to the automix channel.
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Setting Function

Solo Mutes all of the other channels

Automix Modes
To select an automix mode, go to:

MXA710, MXA910, MXA920:[Your device] > IntelliMix > Properties
P300 and IntelliMix Room:[Your device] > Automixer > Properties

Gating
Gating mode delivers fast-acting, seamless channel gating and consistent perceived ambient sound levels. The off attenuation 
setting is applied to all inactive channels, regardless of the number of active channels.

Gain Sharing
Gain sharing mode dynamically balances system gain between open and closed channels. The system gain remains consis­
tent by distributing gain across channels to equal one open channel. The scaled gain structure helps to reduce noise when 
there is a high channel count. When fewer channels are used, the off attenuation setting is lower and provides transparent gat­
ing.

Manual
Manual mode sums all active tracks and sends the summed signal over a single Dante output. This provides the option to route 
an individual signal for reinforcement or recording, without enabling automixing. The settings from the faders in the standard 
monitoring view apply to the summed output.

Automixer Direct Out Tap Points
In the Automixer tab, use the menus below each channel to choose where the signal to the matrix mixer should come from.

All options include input channel gain, mute, solo, and PEQ.

Pre-Processing/Pre-Gate

Sends a signal without AEC, noise reduction, automixer gating, or AGC to the matrix mixer.

Post-Processing/Pre-Gate

Sends a signal with AEC and noise reduction but without automixer gating or AGC to the matrix mixer.

Post-Processing/Post-Gate

Sends a signal with automixer gating, AEC, and noise reduction but without AGC to the matrix mixer.

Pre-Processing/Post-Gate

Sends a signal with automixer gating but without AEC, noise reduction, or AGC to the matrix mixer.

Note: Direct out tap points are not available on all Shure automixers.
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Use Cases
P300 and Computer with Soft Codec

Connect the computer to the USB port on the P300.
Connect a powered loudspeaker or amplifier to the P300 analog output 2. In the matrix mixer, this is labeled Analog - To 
Speaker. You can also use Dante PoE loudspeakers connected to the network switch.
In Designer, go to Matrix mixer to make connections between devices. Some connections are established automatical­
ly.

Required Matrix Mixer Connections:

Input Output

Automix USB output

USB input Analog - To Speaker or Dante output

In Schematic, right-click any AEC block and choose an AEC reference source. The reference source is Analog - To 
Speaker for analog loudspeakers, or one of the Dante outputs for Dante loudspeakers.
Adjust input and output levels using Designer and perform a sound check. Refer to the Help section for additional infor­
mation.

USB Device Type Settings
When you use a USB-connected codec with a P300 or ANIUSB-MATRIX, you may need to set the USB device type on the 
Shure device.

The USB device type setting tells the codec if acoustic echo cancellation (AEC) is needed or not. The codec can then turn on 
or turn off its own AEC (if supported).

For example: You have an MXA710 routed to an ANIUSB-MATRIX and want to use the MXA710's AEC. Set the USB device 
type to Echo­canceling speakerphone to tell the codec to turn off its AEC.



Shure Incorporated

31/49

1.
2.

◦
◦

3.
4.

1.

2.

To change USB device type:

In Designer, find the P300 or ANIUSB-MATRIX and go to Settings > General.
Choose a USB device type:

Speakerphone: For using the codec’s AEC
Echo­canceling speakerphone: For using the Shure device’s AEC

After changing the USB device type, select your device as the default audio device in the codec’s settings.
Place a test call to make sure AEC is working properly.

Connecting a USB Device
The USB port connects the host computer to the entire room audio system, including microphones and loudspeakers.

When the P300 is connected for the first time, the computer recognizes it as a USB audio device. You may need to select it as 
the input/output (recording/playback) device to pass audio. Assign the P300 as the default device to ensure it passes audio 
every time it is plugged in. Refer to the manual for your computer to configure the audio settings.

Adapter Compatibility
This device is compatible with USB­B to USB­C adapters. Using an adapter is only recommended for desktop and laptop com­
puters, as many mobile devices do not support bi-directional audio through USB or lightning ports.

Hardware Codec System

Connect the hardware codec audio output to the P300 analog input 1. In the matrix mixer, this is labeled Analog ­ From 
Codec.
Connect the hardware codec audio input to the P300 analog output 1. In the matrix mixer, this is labeled Analog ­ To 
Codec.
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Connect a powered loudspeaker or amplifier to the P300 analog output 2. In the matrix mixer, this is labeled Analog - To 
Speaker. You can also use Dante PoE loudspeakers connected to the network switch.
In Designer, go to Matrix mixer to make connections between devices. Some connections are established automatical­
ly.

Required Matrix Mixer Connections:

Input Output

Automix Analog - To codec

Analog - From Codec Analog - To Speaker or Dante output

In Schematic, right-click any AEC block and choose an AEC reference source. The reference source is Analog - To 
Speaker for analog loudspeakers, or one of the Dante outputs for Dante loudspeakers.
Adjust input and output levels using Designer and perform a sound check. Refer to the Help section for additional infor­
mation.

Mobile Phone System

In this example, when the phone is plugged in, the built-in microphone and speaker are disabled -- the phone simply carries 
the call. The MXA310 microphone captures near-end audio, and the loudspeaker delivers audio from the far end of the call.

Connect the phone to the P300 with a 1/8-inch TRRS cable.
Connect a powered loudspeaker or amplifier to the P300 analog output 2. In the matrix mixer, this is labeled Analog - To 
Speaker. You can also use Dante PoE loudspeakers connected to the network switch.
In Designer, go to Matrix mixer to make connections between devices. Some connections are established automatical­
ly.
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Required Matrix Mixer Connections:

Input Output

Automix Mobile output

Mobile input Analog - To Speaker or Dante output

In Schematic, right-click any AEC block and choose an AEC reference source. The reference source is Analog - To 
Speaker for analog loudspeakers, or one of the Dante outputs for Dante loudspeakers.
Adjust input and output levels using Designer and perform a sound check. Refer to the Help section for additional infor­
mation.

Mobile Connection Cable Requirements
A 1/8-inch TRRS cable is required to connect a phone to the P300. Avoid using cables with a metal flange, as it may create an 
electrical connection to the exterior of the phone and interrupt the signal.

To ensure proper operation, only use:

Apple-approved cables
Cables with a plastic or non-conductive flange
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Note: If necessary, a TRS (tip/ring/sleeve) cable may be used to plug a stereo device into the P300, but the device will only be able to send audio to the P300. 
The Enable auto-mute feature on the mobile input channel must be turned off in this case.

Encryption
Audio is encrypted with the Advanced Encryption Standard (AES-256), as specified by the US Government National Institute of 
Standards and Technology (NIST) publication FIPS-197.

Encryption is not supported with third-party devices.

Important: For encryption to work:

Devices must be online and support encryption.
Encryption must be turned on for all devices in the room.
You must disable AES67 in Dante Controller. AES67 and AES-256 can't be used at the same time.

To turn on encryption:

In an online room, select  > Audio encryption > Turn on encryption. You can auto generate a key or enter one 
manually.

To re-key or turn off encryption:

In an online room, select  > Audio encryption and enter any passwords.

Set Up the 802.1X Protocol for a Device
Select Shure devices support the IEEE 802.1X port access protocol for network authentication.

Important: To use the 802.1X security protocol with Shure devices, set the network switch to multiple host authentication. You 
must also make accommodations to allow the audio network interface to connect to the network. The audio network interface 
doesn't support the 802.1X protocol.

Setting up 802.1X is a two-part process.

To set up 802.1X, you will need:

Details about your authentication server's EAP method
Any required credentials or certificates for that method, for example:

MD5 and PWD
User ID and passphrase

TLS and PEAP
User ID and passphrase
Certificate (with certificate types) in the .PEM format

Any passwords to access the devices if they are password locked

Step 1: Configure Settings on Test Network
Connect the device to your test network and discover it using Designer.
Initialize the device if necessary. Open the device and go to Settings > Network > 802.1X.
Choose your EAP method from the menu.
Enter any required credentials and load any necessary certificates.
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Press Save to save the 802.1X settings to the device.
Enable 802.1X and select Reboot later.

Step 2: Connect to a Credentialed Network
Connect your device to the credentialed network.
Ensure that Designer is connected to the credentialed network.
Go to Settings > Network > 802.1X and enable 802.1X. Reboot the device for the 802.1X settings to take effect.
If the device doesn’t appear in Designer after the reboot, reconnect to the test network and check all 802.1X settings for 
the selected EAP method.

Turn Off or Clear 802.1X Settings
You can turn off 802.1X settings temporarily, or clear them from the device. Open the device and go to Settings > Network
> 802.1X

Disable: Click the 802.1X switch to turn off 802.1X settings. Click the switch again to enable 802.1X.
Clear: Click Clear 802.1X settings to remove 802.1X settings from the device.

Note: Resetting to factory default clears all 802.1X settings.

Change 802.1X Settings
You may need to change a device’s 802.1X settings if the enterprise’s 802.1X settings are changing. The best way to do this is 
to change the 802.1X settings on the devices, and then make changes to the authentication server.

To change device settings:

While still connected to the credentialed network, find the device in Designer and go to Settings > Network > 
802.1X.
Make changes and click Save.
Make any changes to the authentication server.
Reboot your devices. The devices should connect to the credentialed network with the updated 802.1X settings.

Troubleshooting 802.1X Setup Issues
If the device doesn’t appear in Designer on the credentialed network, there’s a problem with the device’s 802.1X settings. To 
troubleshoot, take the device off the credentialed network and connect it to the test network. You can make any necessary 
changes to the 802.1X settings, and then reconnect to the credentialed network.

If you attempt to enable 802.1X on a device, but the authentication fails, you will see this notification:

If this occurs, check with your system administrator.
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Networking Best Practices
When connecting Shure devices to a network, use the following best practices:

Always use a "star" network topology by connecting each device directly to the switch or router.
Connect all Shure networked devices to the same network and set to the same subnet.
Allow all Shure software through the firewall on your computer.
Use only 1 DHCP server per network. Disable DHCP addressing on additional servers.
Power on the switch and DHCP server before powering on the Shure devices.
To expand the network, use multiple switches in a star topology.
All devices must be at the same firmware revision level.

Switch and Cable Recommendations for Dante Networking
Switches and cables determine how well your audio network performs. Use high­quality switches and cables to make your au­
dio network more reliable.

Network switches should have:

Gigabit ports. 10/100 switches may work on small networks, but gigabit switches perform better.
Power over Ethernet (PoE) or PoE+ ports for any devices that require power
Management features to provide information about port speed, error counters, and bandwidth used
Ability to switch off Energy Efficient Ethernet (EEE). EEE (also known as "Green Ethernet") may cause audio dropouts and 
problems with clock synchronization.
Diffserv (DSCP) Quality of Service (QoS) with strict priority and 4 queues

Ethernet cables should be:

Cat5e or better
Shielded

For more information, see our FAQ about switches to avoid.

Device IP Configuration
This Shure device uses 2 IP addresses: one for Shure control, and one for Dante audio and control. For most installations, the 
Shure control and Dante audio IP addresses should be in the same subnet range.

Shure control
Carries data for Shure control software, firmware updates, and third-party control systems (such as AMX or Crestron)

Dante audio and control
Carries Dante digital audio and control data for Dante Controller
Requires a wired, gigabit Ethernet connection to operate

To access these settings in Designer, go to [Your device] > Settings > IP configuration.

Note:Refer to our FAQ if you're using Shure profiles on NETGEAR M4250-series switches.

Change IP Settings
You can change IP configurations in Shure Designer. By default, they are set to Automatic (DHCP). DHCP enables a device to 
accept IP settings from a DHCP server, or automatically fall back to link­local settings when no DHCP is available. IP address­
es may also be manually set.

To change IP configurations:

Open Designer and go to [Your room] > [Device] > Settings > IP configuration.
Select Auto or Manual. If Auto is used, addresses will be automatically assigned.

https://service.shure.com/s/article/disqualified-network-switches-for-shure-dante-devices?language=en_US
https://service.shure.com/s/article/How-do-I-configure-a-NETGEAR-M4250-series-switch-to-use-Shure-profiles?language=en_US
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For Manual, enter the IP settings.

Setting Latency
Latency is the amount of time for a signal to travel across the system to the outputs of a device. To account for variances in la­
tency time between devices and channels, Dante has a predetermined selection of latency settings. When the same setting is 
selected, it ensures that all Dante devices on the network are in sync.

These latency values should be used as a starting point. To determine the exact latency to use for your setup, deploy the set­
up, send Dante audio between your devices, and measure the actual latency in your system using Audinate's Dante Controller 
software. Then round up to the nearest latency setting available, and use that one.

Use Audinate's Dante Controller software to change latency settings.

Latency Recommendations
Latency Setting Maximum Number of Switches

0.25 ms 3

0.5 ms (default) 5

1 ms 10

2 ms 10+

QoS (Quality of Service) Settings
QoS settings assign priorities to specific data packets on the network, ensuring reliable audio delivery on larger networks with 
heavy traffic. This feature is available on most managed network switches. Although not required, assigning QoS settings is 
recommended.

Note: Coordinate changes with the network administrator to avoid disrupting service.

To assign QoS values, open the switch interface and use the following table to assign Dante -associated queue values.

Assign the highest possible value (shown as 4 in this example) for time-critical PTP events
Use descending priority values for each remaining packet.

Dante QoS Priority Values

Priority Usage DSCP Label Hex Decimal Binary

High (4)
Time-critical PTP 
events

CS7 0x38 56 111000

Medium (3) Audio, PTP EF 0x2E 46 101110

Low (2) (reserved) CS1 0x08 8 001000

None (1) Other traffic BestEffort 0x00 0 000000

Note: Switch management may vary by manufacturer and switch type. Consult the manufacturer's product guide for specific configuration details.

For more information on Dante requirements and networking, visit www.audinate.com.

Networking Terminology
PTP (Precision Time Protocol): Used to synchronize clocks on the network

®
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DSCP (Differentiated Services Code Point): Standardized identification method for data used in layer 3 QoS prioritization

IP Ports and Protocols

Shure Control

Port TCP/UDP Protocol Description
Factory De­
fault

21 TCP FTP Required for firmware updates (otherwise closed) Closed

22 TCP SSH Secure Shell Interface Closed

23 TCP Telnet Not supported Closed

53 UDP DNS Domain Name System Closed

67 UDP DHCP Dynamic Host Configuration Protocol Open

68 UDP DHCP Dynamic Host Configuration Protocol Open

80* TCP HTTP Required to launch embedded web server Open

443 TCP HTTPS Not supported Closed

2202 TCP ASCII Required for 3rd party control strings Open

5353 UDP mDNS Required for device discovery Open

5568 UDP SDT (multicast) Required for inter-device communication Open

57383 UDP SDT (unicast) Required for inter-device communication Open

8023 TCP Telnet Debug console interface Closed

8180 TCP HTML Required for web application (legacy firmware only) Open

8427 UDP SLP (multicast) Required for inter-device communication Open

64000 TCP Telnet Required for Shure firmware update Open

*These ports must be open on the PC or control system to access the device through a firewall.

These protocols require multicast. Ensure multicast has been correctly configured for your network.

See Audinate's website for information about ports and protocols used by Dante audio.

Packet Bridge
Packet bridge enables an external controller to obtain IP information from the control interface of a Shure device. To access the 
packet bridge, an external controller must send a query packet over unicast UDP* to port 2203 on the Dante interface of the 
Shure device.

Send a UDP packet with a minimum 1-byte payload .

Note: The maximum accepted payload 140 bytes. Any content is allowed.

†

†

†

†

https://www.audinate.com/learning/faqs/which-network-ports-does-dante-use
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The Shure device will send a response packet over unicast UDP to the controller, using a destination UDP port identical 
to the source port of the query packet. The payload of the response packet follows this format:

Bytes Content

0-3 IP address, as 32-bit unsigned integer in network order

4-7
Subnet mask, as 32­bit unsigned integer in network or­
der

8-13 MAC address, as array of 6 bytes

Note: The Shure device should respond in less than one second on a typical network. If there is no response, try sending the query again after verify­
ing the destination IP address and port number.

*UDP: User Datagram Protocol

The packet bridge does not allow cross-subnet command strings.

Digital Audio Networking
Dante digital audio is carried over standard Ethernet and operates using standard internet protocols. Dante provides low laten­
cy, tight clock synchronization, and high Quality­of­Service (QoS) to provide reliable audio transport to a variety of Dante de­
vices. Dante audio can coexist safely on the same network as IT and control data, or can be configured to use a dedicated net­
work.

Compatibility with Dante Domain Manager
This device is compatible with Dante Domain Manager software (DDM). DDM is network management software with user au­
thentication, role-based security, and auditing features for Dante networks and Dante-enabled products.

Considerations for Shure devices controlled by DDM:

When you add Shure devices to a Dante domain, set the local controller access to Read Write. Otherwise, you won't be 
able to access Dante settings, perform a factory reset, or update device firmware.
If the device and DDM can't communicate over the network for any reason, you won't be able to control Dante settings, 
perform a factory reset, or update device firmware. When the connection is reestablished, the device follows the policy set 
for it in the Dante domain.
If Dante device lock is on, DDM is offline, or the configuration of the device is set to Prevent, some device settings are dis­
abled. These include: Dante encryption, MXW association, AD4 Dante browse and Dante cue, and SCM820 linking.

Refer to Dante Domain Manager's documentation for more information.

Note: Applies to firmware 4.1.x and newer.

Dante Flows for Shure Devices
Dante flows get created any time you route audio from one Dante device to another. One Dante flow can contain up to 4 audio 
channels. For example: sending all 5 available channels from an MXA310 to another device uses 2 Dante flows, because 1 
flow can contain up to 4 channels.

Every Dante device has a specific number of transmit flows and receive flows. The number of flows is determined by Dante 
platform capabilities.

https://audinate.com/
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Dante Flows for Shure Devices

Dante Platform
Shure Devices Using Plat­
form

Transmit Flow Limit Receive Flow Limit

Brooklyn II
ULX-D, SCM820, MXWAPT, 
MXWANI, P300, MXCWAPT

32 32

Brooklyn II (without SRAM)
MXA920, MXA910, MXA902, 
MXA710, AD4, AD600, 
APXD2

16 16

IP Core
MXA920-V3, MXA902-V3, 
MXA901

32 32

Ultimo/UltimoX
MXA310, ANI4IN, ANI4OUT, 
ANIUSB-MATRIX, ANI22, 
MXN5-C

2 2

DEP ANIUSB-MATRIX-V3 2 2

DAL IntelliMix Room 16 16

Learn more about Dante flows in our FAQs or from Audinate.

AES67
AES67 is a networked audio standard that enables communication between hardware components which use different IP au­
dio technologies. This Shure device supports AES67 for increased compatibility within networked systems for live sound, inte­
grated installations, and broadcast applications.

The following information is critical when transmitting or receiving AES67 signals:

Update Dante Controller software to the newest available version to ensure the AES67 configuration tab appears.
Before turning encryption on or off, you must disable AES67 in Dante Controller.
AES67 cannot operate when the transmit and receive devices both support Dante.

Shure Device Supports: Device 2 Supports: AES67 Compatibility

Dante and AES67 Dante and AES67 No. Must use Dante.

Dante and AES67
AES67 without Dante. Any other au­
dio networking protocol is acceptable.

Yes

Separate Dante and AES67 flows can operate simultaneously. The total number of flows is determined by the maximum flow 
limit of the device.

Sending Audio from a Shure Device
All AES67 configuration is managed in Dante Controller software. For more information, refer to the Dante Controller user 
guide.

Open the Shure transmitting device in Dante Controller.
Enable AES67.
Reboot the Shure device.

https://www.shure.com/en-US/support/find-an-answer/understanding-dante-flows
https://www.audinate.com
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Create AES67 flows according to the instructions in the Dante Controller user guide.

Receiving Audio from a Device Using a Different Audio Network Protocol
Third-party devices: When the hardware supports SAP, flows are identified in the routing software that the device uses. Oth­
erwise, to receive an AES67 flow, the AES67 session ID and IP address are required.

Shure devices: The transmitting device must support SAP. In Dante Controller, a transmit device (appears as an IP address) 
can be routed like any other Dante device.

Using Command Strings
This device receives logic commands over the network. Many parameters controlled through Designer can be controlled using 
a third-party control system, using the appropriate command string.

Common applications:

Mute
LED color and behavior
Loading presets
Adjusting levels

A complete list of command strings is available at:

pubs.shure.com/command-strings/P300.

Troubleshooting
Problem Solution

Software lags in Google Chrome browser
Problem is browser-related. Turn off hardware acceleration 
option in Chrome.

Sound quality is muffled
Use equalizer to adjust frequency response. See the equal­
izer applications for the appropriate use.

Audio sounds too high or too low in pitch

Make sure that the sample rate settings for Playback and 
Recording are the same in your computer's sound settings. If 
these sample rates do not match, the audio may sound too 
high or too low in pitch.

Hardware does not show up in device discovery

Ensure the devices are powered
Ensure PC and equipment are on the same network and set 
to the same subnet
Turn off other network interfaces not used to connect to the 
device (including WiFi)
Check that DHCP server is functioning (if applicable)
Reset the device

https://www.audinate.com/support
https://pubs.shure.com/command-strings/P300
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Problem Solution

No audio

Verify the P300 is selected as the audio device in the audio 
devices or properties panel on the computer
Audio channels must be routed to an output through the ma­
trix mixer
Connections between devices must be established in Dante 
Controller  software
Check cables
Verify that input/output channels are not muted
Check that fader levels are not set too low
Make sure there is not an encryption error -- a passphrase 
mismatch or encryption only enabled on one device disrupts 
audio.

Cannot route Dante audio channels
Install latest version of Dante Controller from Audinate, avail­
able at www.audinate.com.

Hardware does not power on
The network switch must supply Power over Ethernet. Other­
wise, a PoE injector must be used
Check network cables and connections

Event Log
The event log provides a detailed account of activity from the moment the device is powered on. The log collects up to 1,000 
activity entries and time-stamps them relative to the last power cycle. The entries are stored in the internal memory and are not 
cleared when the device is power-cycled. The export feature creates a CSV (comma separated values) file to save and sort the 
log data.

Refer to the log file for details when troubleshooting or when working with Shure support.

To view the event log:

Open the device's web application. As of Designer 6 and newer, there is no longer an event log in Designer.
Select Help > View event log.

Severity Level

Information
An action or event has been successfully completed

Warning
An action cannot be complete, but overall functionality is stable

Error
A problem has occurred that could inhibit functionality.

Log Details

Description
Provides details on events and errors, including IP address and subnet mask.

™
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Time Stamp
Power cycles:days:hours:minutes:seconds since most recent boot-up.

Event ID
Indicates event type for internal reference.

Tip: Use the filter to narrow down results. Select a category heading to sort the log.

Additional Resources
Shure Knowledge Base FAQs
Command strings for Shure devices
Shure Enterprise Networking Troubleshooting Checklist
Training from the Shure Audio Institute
Shure Systems YouTube channel

Download Shure Software
Shure Designer
Shure Update Utility
Shure Web Device Discovery
Software and firmware archive

Specifications
General

Input (2) 3-pin block connector (Active Balanced)

Output (2) 3-pin block connector (Impedance Balanced)

Mobile (1) TRRS 3.5 mm (1/8″)

USB Connections
(1) USB 2.0, Type B

Single port carries 2 input and 2 output channels (Summed mono)

Network Connections (Dante Digital Audio)
(1) RJ45

10 Dante Inputs, 8 Dante Outputs

Polarity
Non-inverting, any input to any output

Power Requirements
802.3 at Type 2 (PoE Plus), Class 4

https://service.shure.com/s/topic/0TO1I000000kRRQWA2/faq
https://pubs.shure.com/command-strings
https://service.shure.com/s/article/enterprise-network-troubleshooting-checklist
https://www.shure.com/en-US/support/shure-audio-institute
https://www.youtube.com/@ShureSystems
https://www.shure.com/designer
https://www.shure.com/suu
https://www.shure.com/en-US/products/software/shure_web_device_discovery_application
https://www.shure.com/en-US/support/downloads/software-firmware-archive
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Power Consumption
17.5 W, maximum

Weight
1710  g (3.8 lbs)

Dimensions
H x W x D

4 x 21 x 22.6 cm ( 1.6 x 8.3 x 8.9 in.)

Control Software
Shure Designer

Operating Temperature Range
−6.7°C (20°F) to 50°C (122°F)

Storage Temperature Range
−29°C (­20°F) to 74°C (165°F)

Thermal Power Dissipation
Maximum 17.5 W ( 60 BTU/hr)

typical 14.6 W ( 50 BTU/hr)

Audio

Frequency Response
+1, ­1.5  dB

20 to 20,000 Hz

Dante Digital Audio
Sampling Rate 48 kHz

Bit Depth 24

USB Audio
Sampling Rate 48 kHz

Bit Depth 16, 24

Latency
Does not include Dante latency

Firmware 4.1 and newer

Dante 1-8 in to Dante out (AEC enabled) 15.4 ms

Dante 1-8 in to Dante out (AEC disabled) 8.7 ms

Dante 9-10 in to Dante out 3.4 ms

Analog in to Analog out 3.8 ms

Firmware 3.1 and older Dante 1-8 in to Dante out (AEC enabled) 12.5 ms
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Dante 1-8 in to Dante out (AEC disabled) 5.8 ms

Dante 9-10 in to Dante out 1.8 ms

Analog in to Analog out 2.2 ms

Acoustic Echo Cancellation Tail Length
Up to 300 ms

Analog Connections (Block Connectors)

Dynamic Range
20 Hz to 20 kHz, A-weighted, typical

Analog-to-Dante 113 dB

Dante-to-Analog 117 dB

Equivalent Input Noise
20 Hz to 20 kHz, A­weighted, input terminated with 150Ω

Line ­86 dBV

Aux ­98 dBV

Total Harmonic Distortion
@ 1 kHz, 0 dBV Input, 0 dB analog gain

<0.05%

Common Mode Rejection Ratio
150Ω balanced source @ 1 kHz

>50 dB

Input Impedance
9.6 kΩ

Input Clipping Level
Line +27 dBV

Aux +15 dBV

Output Impedance
80 Ω

Output Clipping Level
Line +20 dBV

Aux +0 dBV

Mic ­26 dBV
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Mobile Connection (3.5 mm Connector)

Pin Assignments
Tip Audio Input (Left)

Ring 1 Audio Input (Right )

Ring 2 Ground

Sleeve Audio Output (To Phone)

Dynamic Range
20 Hz to 20 kHz, A-weighted, typical

Analog-to-Dante 99 dB

Dante-to-Analog 90 dB

Equivalent Input Noise
20 Hz to 20 kHz, A­weighted, input terminated with 20Ω

­95 dBV

Total Harmonic Distortion
@ 1 kHz, 0 dBV Input, 0 dB analog gain

<0.05%

Input Impedance
3.7 kΩ

Input Clipping Level
+4 dBV

Output Impedance
1.4 kΩ

Output Clipping Level
Output terminated with 2.2 kΩ

­20 dBV

Networking

Cable Requirements
Cat 5e or higher (shielded cable recommended)

Mobile Pin Assignments (TRRS)
Tip Audio Input (Left)

Ring 1 Audio Input (Right )

Ring 2 Ground

Sleeve Audio Output (To Phone)
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Note: The audio input (tip and ring 1) are summed to a mono signal in the P300, to send the signal to any destination on a single channel.

Optional Accessories and Replacement Parts
19" rack tray CRT1

Safety Information
IMPORTANT SAFETY INSTRUCTIONS

READ these instructions.
KEEP these instructions.
HEED all warnings.
FOLLOW all instructions.
DO NOT use this apparatus near water.
CLEAN ONLY with dry cloth.
DO NOT block any ventilation openings. Allow sufficient distances for adequate ventilation and install in accordance 
with the manufacturer’s instructions.
DO NOT install near any heat sources such as open flames, radiators, heat registers, stoves, or other apparatus (in­
cluding amplifiers) that produce heat. Do not place any open flame sources on the product.
DO NOT defeat the safety purpose of the polarized or grounding type plug. A polarized plug has two blades with one 
wider than the other. A grounding type plug has two blades and a third grounding prong. The wider blade or the third 
prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replace­
ment of the obsolete outlet.
PROTECT the power cord from being walked on or pinched, particularly at plugs, convenience receptacles, and the 
point where they exit from the apparatus.
ONLY USE attachments/accessories specified by the manufacturer.
USE only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the apparatus. When a 
cart is used, use caution when moving the cart/apparatus combination to avoid injury from tip-over.

UNPLUG this apparatus during lightning storms or when unused for long periods of time.
REFER all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any 
way, such as power supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, 
the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.
DO NOT expose the apparatus to dripping and splashing. DO NOT put objects filled with liquids, such as vases, on the 
apparatus.
The MAINS plug or an appliance coupler shall remain readily operable.
The airborne noise of the Apparatus does not exceed 70dB (A).
Apparatus with CLASS I construction shall be connected to a MAINS socket outlet with a protective earthing connec­
tion.
To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.
Do not attempt to modify this product. Doing so could result in personal injury and/or product failure.
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Operate this product within its specified operating temperature range.

Note: Model information and power ratings are labeled on the bottom of the unit.

This symbol indicates that dangerous voltage constituting a risk of electric shock is present within this unit.

This symbol indicates that there are important operating and maintenance instructions in the literature accom­
panying this unit.

Important Product Information
The equipment is intended to be used in professional audio applications.

Note: This device is not intended to be connected directly to a public internet network.

EMC conformance to Environment E2: Commercial and Light Industrial. Testing is based on the use of supplied and recommended cable types. The use of 
other than shielded (screened) cable types may degrade EMC performance.

Changes or modifications not expressly approved by Shure Incorporated could void your authority to operate this equipment.

Industry Canada ICES-003 Compliance Label: CAN ICES-3 (B)/NMB-3(B)

Authorized under the verification provision of FCC Part 15B.

Please follow your regional recycling scheme for batteries, packaging, and electronic waste.

Dante is a registered trademark of Audinate Pty Ltd.

Information to the user
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC 
Rules. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance 
with the manufacturer's instruction manual, may cause interference with radio and television reception.

Notice: The FCC regulations provide that changes or modifications not expressly approved by Shure Incorporated could void 
your authority to operate this equipment.

These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equip­
ment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruc­
tions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur 
in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be de­
termined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and the receiver.
Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:

This device may not cause harmful interference.
This device must accept any interference received, including interference that may cause undesired operation.

The CE Declaration of Conformity can be obtained from: www.shure.com/europe/compliance

Authorized European representative:
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Shure Europe GmbH
Global Compliance
Jakob-Dieffenbacher-Str. 12
75031 Eppingen, Germany
Phone: +49-7262-92 49 0
Email: info@shure.de
www.shure.com

This product meets the Essential Requirements of all relevant European directives and is eligible for CE marking.

The CE Declaration of Conformity can be obtained from Shure Incorporated or any of its European representatives. For contact 
information please visit www.shure.com
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